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Chapter 1. Start Here 

This chapter gives you a quick overview of the information provided in this manual and 
points you to the appropriate place to get started. 

WARNINGS! 

1. New installs receive a 5-day temporary license 
The first installation of NetCOBOL for .NET on a machine, whether obtained by downloading 
from our Website or on CDs, comes with a 5-day temporary license. That is the same for 
everyone – whether you have purchased the product, have arranged a trial period, or have 
just downloaded the software without making any arrangement with Fujitsu Computer 
Systems. Once you have installed the product you need to obtain your full or trial 
license from our license server as described in this manual. This is the way the licensing 
works – it is not that you have been sent a product that is something less than you have 
purchased! 

However, the temporary license is ONLY available on machines that have not had a 
NetCOBOL for .NET license (temporary, trial or full) installed on them before. If you are 
upgrading from an earlier release of NetCOBOL for .NET you need to register your license 
after installing V3.1 (when all is working well over the Internet this is normally just a few 
minutes). 

2. Possible non-install of temporary license 
In some rare circumstances, with earlier versions of the software, the temporary license was 
not installed so some people were not able to use NetCOBOL for .NET immediately. If, in the 
unlikely event, you find yourself in this situation, see the instructions “Installing a Temporary 
License” on page 14. These instructions only apply to new installs; if you are upgrading you 
will need to submit the request for a new key. 

3. Look after your full license! 
If you remove NetCOBOL for .NET from a machine, or want to transfer NetCOBOL for .NET to 
another machine, it is important that you follow the instructions in Chapter 4 (page 20) for 
preserving or transferring your licenses. 

Uninstalling and reinstalling to another folder can also result in the loss of your license. 

Failure to preserve your license or transfer your license may result in you having to purchase 
another license so be careful! 

4. Speed Disk defragmentation users 
Please see the section in “Chapter 5. Troubleshooting” on page 23 about an important 
setting you have to make to ensure that Speed Disk does not cause the loss of your 
NetCOBOL for .NET license. 

5. Ensuring consistent response times 
A particular license check is performed at the start of each day which can take significantly 
longer than the regular license checks. See “Ensuring Consistent Development Environment 
and Compiler Response Times” on page 18 for a simple procedure for avoiding the delays. 
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NetCOBOL for .NET and License Management 

NetCOBOL for .NET has license controls built into it. The license control is required for 
anyone using the product beyond the initial temporary period of 5 days. 

The software installation process includes a step of sending an email note to our license 
control server. This server checks that you have a license for the product you are installing 
and returns a site key that fully enables your software. Without the site key, a 5-day 
temporary license is installed. You can run the registration program later to upgrade your 5-
day temporary license to a full license. 

License Management Information 
The license management system used with NetCOBOL for .NET is quite straightforward to 
use – you may find the registration dialogs are all you need. However, to ensure successful 
use of our license management system, this guide provides all the information you need to 
know to install and maintain your licenses.  

Latest Information 
If we find any information that affects your installation or use of the license management 
system (for example, any issues involved with new operating system releases) we will post it 
on this page: 
http://www.netcobol.com/support/licensemanagement.html

Installation and Registration Instructions 

If all you want is an easy-to-follow set of instructions for installing and registering your 
software you can go straight to “Chapter 3. Installing NetCOBOL for .NET” on page 12. 

Explanation of System and Installation Processes 

If you feel more comfortable understanding the license management system and want an 
overview of the installation processes, then you should read Chapters 2 (page 8) and 3 
(page 12) that give overviews of the system and processes. 

Preserving a License over Significant Machine Changes 

Certain machine changes, such as changing a hard disk, can cause you to lose your license. 
The section “Preserving a License over Significant Machine Changes” in Chapter 4 (page 21) 
describes the steps you need to take to avoid this happening. 

 

http://www.adtools.com/support/licensemanagement.html
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Multithreaded Runtime Distribution Package 

When you want to distribute an application that combines NetCOBOL for Windows code with 
multithreaded NetCOBOL for .NET, you will need to install and use the NetCOBOL for 
Windows Server Runtime Application Distribution Kit. 

You need to contact Fujitsu Computer Systems (see page 30) to obtain a serial number for 
the Server Runtime Application Distribution Kit. The serial number will enable you to install 
the Application Distribution Kit from your NetCOBOL for Windows CD.  You can then find 
instructions for using the kit in the NetCOBOL for Windows "Runtime Installation Guide".  

Other Situations 

The rest of the guide covers other situations that you may encounter, such as coping with 
transferring licenses or dealing with losing licenses through machine corruption 
(Chapter 4, page 20), assuring your license will not be lost if you simply uninstall and 
reinstall the product (Chapter 4, page 22) and troubleshooting installation problems 
(Chapter 5, page 23). 

Frequently Asked Questions and  
Contacting Fujitsu Computer Systems 

The appendices provide answers to frequently asked questions (page 28) and 
information on contacting Fujitsu Computer Systems on license-related matters (page 
30). 

 



 

Chapter 2. Overview of License Management 
System 

This chapter gives an overview of the license management system so you can understand 
the various steps you need to take. 

It also provides a glossary of license management terms. 

The License Management System 

It may help you understand the various actions you have to take in certain circumstances by 
understanding how our license management system works. 

There are essentially two parts to the License Management System – a license-managing 
server on the Internet, and license-managing software on the machine that has NetCOBOL 
for .NET installed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

License-managing server 

- Contains the number of full licenses purchased 
or trial licenses arranged 
- Sends site keys in response to email notes 

License-managing software 

- Checks for valid license 
- Helps obtain a site key 
- Provides functions for Killing or 
Transferring licenses 

Site code
+ 

Serial # 

Site key 

Figure 1. License Management System 

When you purchase one or more copies of NetCOBOL for .NET, or arrange for a trial, the 
number and type of licenses are entered on the license-managing server. 

When you install NetCOBOL for .NET on your computer you have 5 days in which to obtain a 
site key from the license-managing server. This is done by sending an email note to the 
server or by faxing/calling Fujitsu Computer Systems for your site key. The email note 
contains an encrypted message that combines your site code (which is unique to your 
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computer) and your serial number (sent to you with the software). The encrypted message is 
generated for you by the license management software and, if your email software supports 
the appropriate interface, can be written and sent for you automatically. If your email 
software does not support the automatic generation and transmission of the email note, you 
simply create an email note under the instruction of a wizard, pasting all the relevant 
information from the system clipboard. 

The site key is used to generate a license on your machine that is checked by the NetCOBOL 
for .NET software at startup. It matches the site code and serial number so can only be used 
on the one machine. 

Each time you obtain a site key, the license managing server decrements the number of 
licenses you have available. Once you have obtained site keys for all the copies of the 
software that you have purchased (or trial copies that you have arranged), the server will not 
issue any more site keys. If you attempt to obtain another site key, it will send you an email 
note telling you that all your licenses have been used. 

Obviously different circumstances can occur that require an extra site key to be generated. 
These circumstances should be covered by one of the following items in Chapter 4  
“Managing Your Licenses”: 

You want to move the NetCOBOL for .NET software to another machine – to do this you 
need to Transfer the license. See “Transferring a License to Another Machine” on page 
20. 

• 

• 

• 

• 

You are upgrading your machine, or reinstalling your operating system, involving 
operations that you fear may cause your license to be removed. See “Preserving a 
License over Significant Machine Changes” on page 21. 

Something happens to your machine, like your hard disk going bad, which means you 
are no longer able to execute the license management software. See “Handling Machine 
Failures that Cause Your License to be Lost” on page 21. 

You want to use the software on multiple machines for reasons such as home-use, or 
use when traveling. See “Using NetCOBOL for .NET on Multiple Machines” on page 22. 

If you think you have a situation that is not explained by any of the above-mentioned 
sections then contact us as explained in the “Handling Machine Failures that Cause Your 
License to be Lost” section on page 21. 
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Glossary of License Management Terms/Functions 

The following is a list of the terms and functions used in the license management system. 

Check: A function on the first NetCOBOL for .NET Registration dialog displayed by the 
license management software. It checks what license is installed on the machine and displays 
that information in a message box. 

Confirmation Code: A code returned by the Kill function when a license is removed 
from the machine. For full licenses it is important to contact Fujitsu Computer Systems before 
executing the Kill function and it is vital that you save this code and send it to Fujitsu 
Computer Systems so that your license count can be incremented by one on the License-
Managing Server. Note that kill codes are not given when killing a trial or temporary license. 

Get Site Key: A function on the second NetCOBOL for .NET Registration dialog, 
displayed by clicking the Register button on the first NetCOBOL for .NET Registration dialog. 
This function either automatically sends an email note to the License-Managing Server or 
invokes a Wizard that helps you create the email message manually. The email note contains 
encrypted versions of the Site Code and Serial Number and triggers a response which 
provides you with a matching Site Key. 

Kill: Word used to describe the process of removing a license from a machine. The Kill 
function returns a Confirmation Code which must be sent to Fujitsu Computer Systems so 
that your license count can be incremented on the License-Managing Server. Important: 
We recommend that you do not use the Kill function on a permanent license until 
instructed by Fujitsu Computer Systems to do so – this ensures there is minimal delay 
in incrementing your license count. 

License-Managing Server: A server on the Internet that keeps track of the 
number of licenses issued to each customer. It waits for emails generated by the Get Site 
Key function and responds to them with license-enabling Site Keys or messages indicating if 
there are problems issuing the Site Key. 

License-Managing Software: Software installed with NetCOBOL for .NET that: 
helps with registering the software, checks that a valid license is installed, and provides 
license maintenance functions such as transferring and killing licenses. 

Register: Term for either invoking the main license controlling dialog, or for writing 
registration information to a floppy disk, or other read/write device that can be addressed by 
a drive letter (e.g. a USB drive or network drive), as the first step in the license transfer 
handshake between two machines. 

Serial Number: A number assigned to each customer or product purchase, which is 
required for product installation and registration. It identifies you to the License-Managing 
Server, enabling it to establish the number of licenses you have available. This number is 
generally printed on a label on your CD sleeve or is supplied to you in e-mail if you received 
it as part of an upgrade. After your first installation it is stored and offered to you as the 
default serial number for subsequent installations on the same machine (so if you have to 
uninstall and reinstall, your Serial Number is remembered). 

 



Chapter 2. Overview of License Management System      11 

Site Code: A code generated that is unique to your machine. It is sent to the License-
Managing Server along with your Serial Number in an email note generated by the Get Site 
Key function. 

Site Key: A code that is returned to you by the License-Managing Server, in response to 
the email note sent by the Get Site Key function. The Site Key will only work with the correct 
pair of Site Code and Serial Number. When you receive your Site Key, you use the Validate 
function to check the Site Key and register your license on your machine. 

Transfer In: Function for receiving a license transferred from another machine. A 
read/write device that can be addressed by a drive letter (e.g. floppy disk, USB drive, 
network drive) is used to perform the transfer. The process starts on the Transfer In 
machine, which writes machine-specific information to the drive. The device is either moved 
to the Transfer Out machine or addressed from that machine, where it receives the license – 
encoded using the machine-specific information. The process is concluded by using the 
Transfer In function again to copy the license from the device to the Transfer In machine. 

Transfer Out: Function for moving a license off a machine to another machine. A 
read/write device that can be addressed by a drive letter (e.g. floppy disk, USB drive, 
network drive) is used to perform the transfer. The Transfer Out function takes machine-
specific information written to the device by the Transfer In function on another machine. It 
uses this information to create a license for the target machine and writes that to the device. 
It then removes the license from the current machine. 

Validate: Function used to validate a Site Key and establish a license on the machine. 

 

 



 

Chapter 3. Installing NetCOBOL for .NET  

This chapter provides summaries of each of the different installation scenarios you are likely 
to encounter. The summaries provide sufficient context for you to dive in and get going. 

The installation scenarios covered are: 

Installing NetCOBOL for .NET V3.1 for the first time • 

• 

• 

• 

• 

• 

Upgrading to NetCOBOL for .NET V3.1 from an earlier release (such as V2.1) 

Upgrading to NetCOBOL for .NET V3.1 from NetCOBOL for Windows 

Upgrading a Trial License to a Full License 

Extending a Trial Period 

Ensuring Consistent Development Environment and Compiler Response Times 

Note that Chapter 2 contains a glossary of terms used in the license management system on 
page 10. This can be helpful if you are unsure about what a particular function does. 
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Installing NetCOBOL for .NET V3.1 for the First Time 

The steps for installing NetCOBOL for .NET V3.1 are as follows: 

1. Install Visual Studio 2005 
 
Visual Studio 2005 must be installed before installing NetCOBOL for .NET. Note: Express 
editions of Visual Studio 2005 are not sufficient. 
 
If you do not have Visual Studio 2005, a copy of Visual Studio 2005 Standard Edition can 
be obtained by purchasing a NetCOBOL for .NET Media Kit, which can be ordered by 
sending an e-mail to cobol@netcobol.com.  
 
If you obtained your copy of Visual Studio 2005 from a NetCOBOL for .NET Media Kit, 
please insert Disc 1 and follow the instructions provided through the installation process. 
Note that your Visual Studio 2005 product key is located on a label on the back of the 
Visual Studio 2005 Disc 1 sleeve. 

2.  Install NetCOBOL for .NET 
 
Insert the NetCOBOL for .NET V3.1 CD. The NetCOBOL for .NET dialog should display 
automatically. If the dialog does not display, select the CD in Windows Explorer and 
execute the Setup.exe program. 
 
If you downloaded NetCOBOL for .NET V3.1, navigate to the folder in which you 
unzipped the download package and execute the Setup.exe program. Note: The 
download contents are the same as the CD contents. 
 
 After completing the installation of NetCOBOL for .NET, you automatically have a 5-day 
temporary license if you have not previously installed any version of NetCOBOL for .NET. 
Continue with the instructions “To Register Your Product and Obtain Your Full or Trial 
License” below. 

To Register Your Product and Obtain Your Full or Trial License: 
Within the 5-day temporary license period you need to register your product to obtain a Site 
Key and install your full or trial license on your machine. We suggest you take this action 
immediately so it is done, and you don't find yourself panicking in 5 days' time! 

NOTE: If you receive a message during installation stating “Network Driver Not Serving this 
Directory”, then the 5-day temporary license will not have been installed. You can either 
continue with the following instructions to obtain your full or trial license or follow the 
instructions in “Installing a Temporary License” below. 

1. From the Start, Programs menu, select Fujitsu NetCOBOL for .NET v3.1, Registration. 
This displays the Fujitsu NetCOBOL for .NET Registration dialog. 

2. On the first dialog you enter your serial number (including hyphens or dashes) and click 
on “Register”. 

3. In the second dialog you click on “Get Site Key”. 

 



14      Chapter 3. Installing NetCOBOL for .NET       

4. What happens next depends on whether your email program supports the automatic 
generation of email notes or not. 
- If it does, an email note is created for you, and you just have to ensure that the note 
is sent and wait for a reply with your Site Key. 
- If it doesn’t, a wizard is invoked that guides you through the steps of creating an email 
note – it puts the appropriate text on the clipboard, which you then paste into your 
email note.  
- If your machine doesn’t handle email then you need to paste the text from the wizard 
into a text file and take the text file to a machine that does handle email. You can then 
send a note from that machine using the wizard-generated information. 

5. When you receive your Site Key, copy and paste it into the Site Key field and press the 
Validate button. A message is displayed saying that your site key has been accepted. 
Note: You are not required to leave the registration program open between the time 
that you submit your email and the time that you receive your site key to validate it. You 
can simply restart the registration utility in order to validate your site key. 

6. You then exit out of the dialogs and you are done. 

Using NetCOBOL for .NET: 
There is a Fujitsu NetCOBOL for .NET v3.1 menu on your Start, Programs menu that 
contains utilities, the Language Reference and Readme. However, you will generally use 
NetCOBOL for .NET from within Visual Studio. 

A good starting point is the Fujitsu NetCOBOL for .NET User Guide that you'll find in the 
Microsoft Visual Studio Documentation system. You can access this from the Fujitsu 
NetCOBOL for .NET v3.1 menu. 

Installing a Temporary License 
If you are installing on a machine that has not had a NetCOBOL for .NET license of any 
version or any type, and you find that the 5-day temporary license is not installed, you can 
install the temporary license by executing the program: 

C:\Program Files\Fujitsu NetCOBOL for .NET v3.1\Regsoft\FujitsuSetTrial.EXE 

(assuming you installed to the default drive/directory). This allows you to start using your 
product immediately rather than waiting the few minutes it normally takes to register the 
product and receive your site key.  

The temporary license cannot be installed on machines that have previously had a NetCOBOL 
for .NET license installed – whether temporary, trial or full. 

Upgrading to NetCOBOL for .NET V3.1 from an Earlier Release 

The process for upgrading to NetCOBOL for .NET V3.1 from an earlier release of NetCOBOL 
for .NET is almost identical to the process of installing NetCOBOL for .NET from scratch. The 
only points of difference are:  

Make sure you use the serial number provided with your V3.1 product, as this is the 
number recorded on the License Management Server. It is different from the serial 
number provided with earlier releases, since the system maintains a relationship between 
serial numbers and product releases. If you use a previous serial number to try to 

• 
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register the V3.1 product, the product will fail to work, indicating an inappropriate level 
number of the license, 

If you will be using NetCOBOL for .NET V2.1 to maintain projects or solutions created 
with Visual Studio .NET 2003, you do not have to uninstall the V2.1 release. V3.1 can be 
installed on the same machine as NetCOBOL for .NET V2.1 or earlier versions.  
Projects and solutions created with earlier releases will be converted to the Visual Studio 
2005 format the first time they are opened with Visual Studio 2005, after you confirm 
that this should be done. 

• 

NOTES:  

1. When upgrading you do NOT receive the temporary 5-day license. You must register 
your product immediately to activate it. 

2. If you are installing NetCOBOL for .NET on a machine that contains NetCOBOL for 
Windows V8 (or earlier) there is no special action that you need to take (except when 
you are upgrading from NetCOBOL for Windows as described in the next topic). 
NetCOBOL for .NET is installed to a different folder structure and does not interfere with 
the operation of your NetCOBOL for Windows product. 

Upgrading to NetCOBOL for .NET V3.1 
from NetCOBOL for Windows 

Because there are three editions of NetCOBOL for .NET (Professional, Developer and 
Universal) and there are two editions of NetCOBOL for Windows (Professional and Enterprise) 
with a third edition that is no longer sold separately (Standard), there are different possible 
upgrade scenarios each requiring slightly different actions. This section describes the 
different actions. 

If you are moving from one machine to another or upgrading from Windows 98 or Windows 
Me at the same time as upgrading your NetCOBOL for Windows product, you need to follow 
the actions described in either “Preserving a License over Significant Machine Changes” (page  
21) or “Transferring a License to Another Machine” (page 20). 

The following table summarizes the actions you need to take. Note that it assumes that you 
are replacing your NetCOBOL for Windows product with a NetCOBOL for .NET edition. This 
table does not apply if your purchase of NetCOBOL for .NET was completely separate from 
your current NetCOBOL for Windows (or Fujitsu COBOL) license (i.e. you didn’t upgrade your 
Windows product to a .NET product). The table abbreviates actions and product names; see 
the notes below the table for explanations of the abbreviations. 

You are provided the appropriate serial numbers with your NetCOBOL for .NET Media Kit or 
by email if you choose to download your software. 
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Summary of NetCOBOL for Windows to NetCOBOL for .NET Upgrade Actions 

NetCOBOL for .NET To 

From Professional Developer Universal 

Standard Kill NCW Standard license
Uninstall NCW Standard 
Install NetCOBOL for .NET 

Install NetCOBOL for .NET
 

Kill NCW Standard license 
Install NCW with Ent. S/N 
Register NCW Ent 
Install NetCOBOL for .NET 

Professional Kill NCW Prof. license 
Uninstall NCW Prof. 
Install NetCOBOL for .NET 

Kill NCW Prof. license 
Uninstall NCW Prof. 
Install NCW Standard 
Register NCW Standard 
Install NetCOBOL for .NET 

Kill NCW Prof. license 
Install NCW with Ent. S/N 
Register NCW Ent 
Install NetCOBOL for .NET 

NetCOBOL 
for 
Windows 
(or Fujitsu 
COBOL for 
Windows) 

Enterprise Kill NCW Ent. license 
Uninstall NCW Ent. 
Install NetCOBOL for .NET 

Kill NCW Ent. license 
Uninstall NCW Ent. 
Install NCW Standard 
Register NCW Standard 
Install NetCOBOL for .NET 

Install NetCOBOL for .NET
 

Explanations of abbreviated names and actions used in table: 

NCW – NetCOBOL for Windows (Fujitsu COBOL for Windows if you have an earlier release) 

Prof. – Professional 

Ent. – Enterprise 

S/N – Serial Number 

Kill xxx license – This is a function of the license-managing software. It removes your 
license from the machine, effectively disabling your product. By communicating your kill 
confirmation code to Fujitsu Computer Systems we know that you are no longer using that 
license. The steps for killing a license are: 

Unless you are upgrading to the Universal edition, contact Fujitsu Computer 
Systems and inform us that you desire to kill a license. When you receive 
confirmation to go ahead, proceed with the following steps as soon as possible. 

• 

• 

• 

• 

Invoke the Registration software and select the Kill function on the Register dialog. 

Copy or record the confirmation code. 

Send the confirmation code to Fujitsu Computer Systems (cobol@netcobol.com) along 
with your serial number and the appropriate email address to which a response should 
be sent. 
You'll be told when the license-managing server's license count has been incremented. 

Uninstall xxx – Use the Windows Control Panel, Add or Remove Programs function to 
uninstall the product. This is necessary when you are downgrading or removing your 
Windows product. 

Install NetCOBOL for .NET – Follow the steps described earlier in this chapter in 
“Installing NetCOBOL for .NET V3.1 for the first time” to install and register the NetCOBOL 
for .NET software. 

Install NCW Standard – Install the Standard edition of NetCOBOL for Windows, using the 
Standard Edition serial number provided to you with your NetCOBOL for .NET edition. 

Install NCW with Ent. S/N – When you are upgrading your edition of NetCOBOL for 
Windows, after killing your lower-level license, you just invoke the installer and enter your 
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Enterprise edition serial number. You can then select the Enterprise-level components you 
wish to install. Note that the product will not work until you register your Enterprise serial 
number and validate the matching site key. 

Register NCW xxx – After installing your NetCOBOL for Windows Standard or Enterprise 
editions you must register the product with your new serial number. Because you killed your 
license before the installation, your product will not work until you perform the registration 
step and validate the returned site key. 

Upgrading a Trial License to a Full License 

If you first obtained NetCOBOL for .NET as a trial product and then decided to purchase it, 
you will need to upgrade your trial license to a full license. 

If you have not yet purchased a full license from Fujitsu Computer Systems then you need to 
contact Fujitsu Computer Systems or your Sales Rep to purchase your license.  

When you have purchased a new license you invoke the NetCOBOL for .NET Registration 
software from the Fujitsu NetCOBOL for .NET menu (Start>Programs>Fujitsu NetCOBOL for 
.NET v3.1>Registration). 

You then pick up on the “Installing NetCOBOL for .NET V3.1 for the first time” instructions 
above at step 5 (page 13). 
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Extending the Trial Period 

Extending your trial period is very similar to upgrading from a trial license. You first need to 
contact Fujitsu Computer Systems or your sales rep to arrange the trial extension. Once this 
has been approved we will enter the agreed extension period on the License Management 
Server.  

You then invoke the NetCOBOL for .NET Registration software from the Fujitsu NetCOBOL for 
.NET menu (Start>Programs>Fujitsu NetCOBOL for .NET v3.1>Registration) and pick up on 
the “Installing NetCOBOL for .NET V3.1 for the first time” instructions at step 5 (page 13).  

Instead of receiving a full license, you receive a license that extends your use of the product 
by the agreed number of days. 

Ensuring Consistent Development Environment and Compiler 
Response Times 

Because a special license check is performed at the start of each day, which can take 
significantly longer than the regular license checks, we recommend that you trigger this 
check deliberately at least once a day and when your system starts up. That way when you 
start to use a Visual Studio COBOL project or compile a COBOL program you won’t notice any 
unusual delays. 

A simple way of triggering the check is to compile one of the example programs such as 
“HelloWin.cob”. This operation can be scheduled using the task scheduling feature of the 
Windows operating system – check your Windows help and support center to confirm how to 
schedule tasks on your version, but you may find the following instructions are sufficient. 

You can schedule the compile by selecting “Start>All Programs>Accessories>System 
Tools>Scheduled Tasks” and selecting the “Add Scheduled Task” item in the “Scheduled 
Tasks” list. This starts the “Scheduled Task Wizard” which steps you through the process of 
scheduling the task. Details you need to know: 

The program you want to run is cobolc.exe that you will find in: 
C:\Program Files\Fujitsu NetCOBOL for .NET\COBOL\cobolc.exe 

• 

• 

• 

• 

• 

• 

• 

• 

To the selected program name you need to add the commandline parameters for 
compiling HelloWin.cob. It’s best to copy these from the file called “Makefile” in the  
C:\Program Files\Fujitsu NetCOBOL for .NET\Examples\CommandLine\HelloWin 
folder. You’ll need everything after “cobolc” in the line containing “cobolc”. 

The “Start in:” folder needs to be set to: 
C:\Program Files\Fujitsu NetCOBOL for .NET\Examples\CommandLine\HelloWin 

In the Wizard select that you want to perform the task daily 

Select a suitable start time (such as an hour before you normally start work) 

Enter a user name and password that will enable the task to execute 

On the final Wizard dialog, select that you want to open the advanced properties for the 
task when you click Finish – this enables you to set up other times 

On the Schedule tab of the Properties, select “Show multiple schedules”. 
This allows you to create another schedule (using the New button) which can be 
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scheduled “At System Startup” (one of the selections in the “Schedule Task” drop-down 
list). 

When you have setup this task, right click on the task in the “Scheduled Tasks” list and 
select Run from the context menu. If it is successful there should be no message in the 
Status column, and the “Last Result” column should display “0x0” – a return code of 
zero. 

• 

With this task scheduled you won’t experience any delays when you use NetCOBOL for .NET. 

 



 

Chapter 4. Managing Your Licenses 

This chapter covers the different situations that may arise during the life of your NetCOBOL 
for .NET license. The situations described are: 

Transferring a License to Another Machine • 

• 

• 

• 

• 

Preserving a License over Significant Machine Changes 

Handling Machine Failures that Cause Your License to be Lost 

Uninstalling and Reinstalling the Product 

Using NetCOBOL for .NET on Multiple Machines 

Transferring a License to Another Machine  

If you have installed NetCOBOL for .NET on a machine, and obtained and validated a Site 
Key, then later decide to move the product to another machine, there is a process you need 
to follow to transfer your license. It requires that both machines can read and write to one of 
the following:  

A floppy disk.  • 

• 

• 

• 

• 

• 

• 

• 

A USB drive  

A network drive  

- basically any read/write device that can be addressed using a drive letter like "X:". 

NOTE: The interface indicates that the drive letter should be for a floppy drive. However, 
you can point to any read/write device that can be addressed by a drive letter. 

If either machine does not have access to such a device, then you need to Kill your license 
on the original machine, and reinstall the product on the new machine. See “Preserving a 
License over Significant Machine Changes” for details of the Kill and reinstall process. But be 
aware that you need to contact Fujitsu Computer Systems before performing the 
Kill function on a full license, and the reinstatement may take as long as 1-2 
business days – using the license transfer functions lets you enable NetCOBOL 
immediately. 

The process for transferring your license is: 

Install NetCOBOL for .NET on the new machine and, for new installations, remove (or 
Kill) the temporary license. 

On the new machine use the “Transfer In” function to first register some information 
on the drive you specify with a drive letter. 

On the original machine use the “Transfer Out” function to transfer the license to the 
same device – if you are using a floppy disk or USB drive you insert those in the original 
machine and specify the appropriate drive letter; if you are using a network drive you 
specify the appropriate drive letter to point to that drive. 

Return to the new machine and use the “Transfer In” function to transfer the license 
to the new machine. 

Uninstall NetCOBOL for .NET from the old machine. 
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Preserving a License over Significant Machine Changes  

Certain machine changes, such as replacing the hard drive on which the NetCOBOL for .NET 
software is installed or upgrading from Windows 98 or Me to Windows 2000 or XP, will cause 
you to lose your license – unless you take the appropriate action.  

Before you embark on these significant machine changes you need to execute a process 
called “Killing” your license. Basically this removes your license from your machine and gives 
you a confirmation code. You can then email this confirmation code to Fujitsu Computer 
Systems and we will add 1 to the number of licenses available to you. You can then make the 
changes to your machine and reinstall your NetCOBOL for .NET product, obtaining a new site 
key from the license-managing server. 

The steps for killing and reinstating a license are: 

Contact Fujitsu Computer Systems and inform us that you desire to kill a 
license. When you receive confirmation to go ahead, proceed with the following steps as 
soon as possible. 

• 

• 

• 

• 

• 

• 

• 

• 

Invoke the Registration software and select the Kill function on the Register dialog. 

Copy or record the confirmation code. 

Send the confirmation code to Fujitsu Computer Systems (cobol@netcobol.com) along 
with your serial number and the appropriate email address to which a response should 
be sent. 
You'll be told when the license-managing server's license count has been incremented – 
this process may take as long as 1 or 2 business days. 

Remove NetCOBOL for .NET using the Windows Control Panel, Add/Remove Programs 
function. 

Perform your significant machine change. 

Reinstall NetCOBOL for .NET. 

Reregister NetCOBOL for .NET (after you have received confirmation that your license 
count has been incremented). 
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Handling Machine Failures that Cause Your License to be Lost 

If you are in the unfortunate position to have experienced a machine failure that causes your 
license to be lost, such as losing a hard disk, the only recourse is to email Fujitsu Computer 
Systems describing the situation, attaching proof of the incident (such as an invoice showing 
the purchase of a replacement drive, or repair work performed). After verifying the incident, 
our support personnel will be happy to reinstate your license so you can reinstall your 
product on your new or repaired machine. 

Please include your serial number in your email, and send it to: cobol@netcobol.com

Uninstalling and Reinstalling the Product 

Occasionally you may decide, or be instructed, to try to resolve a problem by uninstalling and 
reinstalling the product. As long as you do not delete the folder in which the product was 
installed your license will be preserved and there will be no need to reregister after you 
reinstall the product. 

Using NetCOBOL for .NET on Multiple Machines 

You may have the need for one user to have NetCOBOL for .NET on multiple machines. For 
example, a programmer may want to take work home and continue to develop his programs 
on his home PC, or he may have a notebook computer which he uses when traveling, or he 
may have both. 

In this situation you should talk to your sales representative to obtain our dual license.  

We also need to update your entry in our license control server to enable you to do this. 

 

mailto:cobol@netcobol.com


 

Chapter 5. Troubleshooting 

This chapter covers possible errors that may be encountered when installing NetCOBOL for 
.NET licenses. 

General Guideline 

A general recommendation when troubleshooting problems in the area of obtaining licenses 
is to be careful! Rushing to try several different ways round a problem may result in you 
obtaining and using more than one license (if your company has purchased more than one 
license). This fact may not come to light for several months – only becoming an issue when 
all licenses are used up, by which time exactly what went on in an early install has been 
forgotten. We would prefer that you email, fax or call us to help us resolve the problem 
before licenses are consumed. 

Problems with Resolutions 

Possible Conflicts with Speed Disk Defragmentation 
The licensing mechanism has, in general, no conflicts with other software. However, we have 
found that there is one defragmentation utility, Speed Disk included with Symantec’s Norton 
Utilities, which can interfere with the licenses.  

Speed Disk moves hidden licensing files, which causes license loss. The licensing files are 
hidden system files that reside in the same directory as the Fujitsu product.  

Resolution: 

Speed Disk provides the following simple steps that enable you to avoid license loss:  

1. Open Speed Disk, and choose File > Options > Customize > Unmovable Files. 

2. Specify that the *.ent, *.rst, and *.key files cannot be moved. 

3. Choose File > Options > Optimization > Save to save the new profile. 

You should now be able to safely defragment your disk with Speed Disk without losing your 
NetCOBOL for .NET license. Note that these procedures are not necessary with most other 
defragmentation utilities, including the default defragmenter available with Windows. 

“No More Keys for this Serial Number Available” 
If, instead of a site key in the email response from the registration server, you get the 
message: 
“-nnnnn No more keys for this serial number available.  Add more keys for this customer 
using CasperDB.exe.” 

you are being told that you have used all the licenses purchased for this product. 
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Do not look for “CasperDB.exe”! The message is generated automatically by the registration-
management software, and this program is used by Fujitsu Computer Systems staff to 
update licenses on the server. 

Resolution: 

Contact Fujitsu Computer Systems to confirm the number of licenses you have purchased, 
the number you have used, and whether you need to purchase more licenses. See 
“Contacting Fujitsu Computer Systems” on page 30. 

“Serial Number is Probably not Valid” 
If, instead of a site key in the email response from the registration server, you get the 
message: 
”-nnnnn No data returned in query of customer data;  serial number is 
probably not valid.  Check the customer's information using CasperDB.exe. 
(serial number: nn-nnnnn-nnnnn)” 
you are being told that you have submitted a serial number that is not entered in our 
database of registered serial numbers. 

Resolution: 

The chances are that the serial number has been entered incorrectly. Check the serial 
number that is displayed in the NetCOBOL for .NET Registration dialog. If it is incorrect, 
correct it and go through the “Get Site Key” process again. 

If you are confident that the serial number has been entered correctly, and test this by re-
entering, re-checking and re-submitting the serial number, then it may be that there is a 
problem at the registration server end. Contact Fujitsu Computer Systems describing your 
problem so that we can help you resolve it. See “Contacting Fujitsu Computer Systems” on 
page 30. 
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“You Already have an Unlimited License” 
If, when you attempt to validate a site code, you receive the message: 

 

 

 

you are being warned that you already have a valid license installed.  
The best action is to Cancel out of this dialog.  

Only click OK if you are working with a Fujitsu Computer Systems support rep who has told 
you that this is a correct action. Normally responding “OK” will cause you to overwrite a valid 
license, causing it to be lost (and licenses cost money). 

Resolution: 

If you do not think you should have seen this message, or are unable to use your product 
after canceling out of this dialog, contact Fujitsu Computer Systems to discuss the situation 
with us. See “Contacting Fujitsu Computer Systems” on page 30. 

“Sitekey does not match current Site Code” 
If, when validating a site key, you get the message: 

“SITEKEY DOES NOT MATCH CURRENT SITE CODE” 
you are being told that the system believes it has been given a site key that does not match 
the site code – a code that identifies the installation machine and product, among other 
details. 

It is possible that: 

The site key has been entered or transferred incorrectly. • 

• 

• 

A site key for a different product has been entered. 

A site key for the same product on a different machine has been entered. 

Resolution: 

1. Check that you have entered or transferred the site key correctly. Click on Validate again 
after correcting the site key. 

2. If you have requested site keys for more than one product check that you have provided 
the correct site key for the product.  
Note: It is not easy to distinguish site keys so it is safest to register one product at a 
time. 
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3. If you are registering products on more than one machine check that you have provided 
the correct site key for the machine. 
Note: It is not easy to distinguish site keys so it is safest either to make sure that you 
are sending and receiving the registration emails using unique email addresses for each 
machine, or register the product on one machine at a time. 

4. If none of the above resolve the problem, contact Fujitsu Computer Systems. See 
“Contacting Fujitsu Computer Systems” on page 30. 

“Program moved or Sitekey Bad Password” 
If, when validating a site key, you get the message: 

 “PROGRAM MOVED OR SITEKEY BAD PASSWORD” 
you are being told that the registration software has detected some unexpected behavior. 

It is possible that: 

The software has been moved between generating the registration request and 
validating the site key. For example, the software might have been uninstalled and 
reinstalled to a different location. 

• 

• The site key has been entered or transferred incorrectly. 

Resolution: 

1. Check that you have entered or transferred the site key correctly. Click on Validate again 
after correcting the site key. 

2. If you have moved the software between registration request and validating the site 
key, you can try uninstalling the software and reinstalling to the original location. Then 
provide your site key when you get to the NetCOBOL for .NET Registration dialog with 
the Validate button. 

3. If neither of these actions resolve your problem contact Fujitsu Computer Systems. See 
“Contacting Fujitsu Computer Systems” on page 30. 
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Site Code Product Number does not Match  
Serial Product Number 
If, instead of a site key in the email response from the registration server, you get the 
message: 
”10061 Product number from site code does not match product number for this serial 
number.  You are using the serial number for the wrong product. 
Check the casper.log file for details and make sure that the data is set up 
correctly in CasperDB.exe.” 
you are being told that your email suggests you are installing a different product than the 
registration database expects. 

The most likely cause of this message is an administrative error at the Fujitsu Computer 
Systems end. We don’t expect this to happen, but if it does, you need to know that you 
should contact Fujitsu Computer Systems. 

Do not look for “CasperDB.exe”! The message is generated automatically by the registration-
management software, and this program is used by Fujitsu Computer Systems staff to 
update licenses on the server. 

Resolution: 

Contact Fujitsu Computer Systems and tell us the error message you received. Say that you 
believe that the Casper database may have the wrong product entered for the serial number 
you have been given. See “Contacting Fujitsu Computer Systems” on page 30. 

 



 

Appendix A. Frequently Asked Questions 

This appendix lists the questions most frequently asked about the license management 
system. 

1. The “Transfer In” button is grayed out. I can't transfer in another 
license.  
Why is this happening?   
How do I get around this problem? 
The “Transfer In” button is disabled if the registration system detects any valid license, 
including the 5-day temporary license or a trial license.  
First use the Check button on the first NetCOBOL for .NET License dialog, to make sure what 
type of license is on the machine.   
If it is a full license (not a temporary or trial license), you have no need to transfer in another 
license.  
If the license is a temporary or trial license then you should use the Kill button to kill this 
license. The “Transfer In” button will then be enabled and you can take the steps to transfer 
in the license from the device used in the “Transfer Out” process.  
Transferring licenses is described in the section “Transferring a License to Another Machine” 
on page 20 above. 
Using the Kill function is described in the section “Preserving a License over Significant 
Machine Changes” on page 21 above. If you are killing a trial license, no confirmation code is 
issued. 

2. I want to make some system changes on my operating system.  
Do I need to protect my license?  How?   
Most operating system changes do not affect your license.  Even reinstalling your operating 
system should not affect the license, provided that you do not reformat your hard disk as 
part of the reinstall, or otherwise damage your folder structure. 

If you believe that a particular operating system change is going to erase your NetCOBOL for 
.NET folder structure or contents then you should follow the instructions described in the 
section “Preserving a License over Significant Machine Changes” on page 21 above.    

3. What if my hard drive crashes?  What do I do with the license?  
Do I lose it for good? 
We understand these things can happen without warning.  Simply e-mail us about your 
situation. We will reinstate your license on our license-managing server.  
Once you have recovered or replaced your machine you can reinstall Fujitsu COBOL. If you 
need to use the product before you hear back from us (for example, if you encountered 
these problems at the beginning of a weekend) then the 5-day temporary license that is 
initially installed with the product, should give you sufficient time to continue with your work. 
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4. I want to use SCAN DISK on my drive.  
Should I know about something before doing this? 
No. Scan disk causes no problems with the licensing software. 

There is one defragmentation utility, Speek Disk provided with Symantec’s Norton Utilities 
that can cause problems. See  “Possible Conflicts with Speed Disk Defragmentation” on page 
23 above for a description of the simple work around for this software. 

5. When I try to execute NetCOBOL for .NET I get a message saying 
“This file is not authorized at this site: AUTHORIZATION NOT 
PRESENT”. 
or 
When I execute the Check function in the NetCOBOL for .NET 
Registration program, I get the message “Product is not 
authorized”. 
a) Why?   
b) What do I do to fix it?   
a) You get this message if there is no valid license installed, including the situation in which 
your 5-day temporary license has expired. 
b) To fix the situation you need to register your software using the NetCOBOL for .NET 
Registration program.  
Invoke this program by selecting Start>Programs>Fujitsu NetCOBOL for .NET 
v3.1>Registration. 
Follow the steps to register your software by getting a site key and validating it. 

 

 



 

Appendix B. Contacting Fujitsu Computer Systems 

Before contacting Fujitsu Computer Systems about a license problem make sure that you 
have the following at hand, or that you provide the following information in any written 
communications: 

Your name • 

• 

• 

• 

• 

• 

• 

Your company name 

Your fax number to which a reply should be sent (if applicable) 

Your telephone number  

The product that you are registering (e.g. “NetCOBOL for .NET Universal”) – displayed on 
the Product box. 

The 18 digit Site Code – displayed in the Site Code box. Double check that you have this 
exactly right. 

The 12 digit Serial Number – displayed in the Serial Number box. 

You can contact Fujitsu Computer Systems using any of the following methods: 

1. Use the Web Support Tool, also called ServiceWise, (registered users only), instructions 
for which follow. Advantage of the tool is that it allows you and us to track the progress 
of resolving your questions or problems. 

- You can access the Web Support Tool from the Support page at 
http://www.netcobol.com/support/  

- Log on using your full e-mail address in lower case as ID and the password sent to 
you when you requested access to the Web Support Tool.  

- To create a new incident go to Submit New, Create New Incident, fill out the New 
Incident form entirely, provide a short description of your problem or question and 
click Submit.  

- Your communication with Tech Support will continue via the Web Conversation tool.  

- To attach a file to an existing incident go to New Event, File Attachment and provide 
the Name and a Description of the attachment (optional). Click Submit, then Browse 
to select the file. The second Submit attaches it. 

- For more information see the Web Support Tool guide 

2. Email site key and sales related questions to: cobol@netcobol.com 
Technical support questions (such as software not behaving as described in this manual) 
should use the Web Support Tool described in 1. If you are having problems with the 
Web Support Tool, but aim to revert to the Web Support Tool as soon as those problems 
are resolved, you can email your problem to: support@netcobol.com  

3. Phoning: Sales-related questions only should use +1-408-428-0300. Our support and 
license management staff are only available through the Web Support Tool and email. 

4. Fax to: +1-408-746-6369 

- This may be a useful fallback if, for some reason, email is not a possibility. 

 

 

http://software.fsw.fujitsu.com/FS/CLogin.dll?ProjectID=11&RunTimeKey=%27COBOL
http://www.netcobol.com/support/
http://www.netcobol.com/download/ServiceWise_Guide.pdf
mailto:cobol@netcobol.com
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Transfer Out function, 11, 20 

transferring licenses, 5, 20 

trouble shooting, 23 

uninstalling, 5, 22 
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